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eWallet Overview
Welcome to eWallet!
Welcome to Ilium Software eWallet®, the award-winning way to safely and conveniently store your
important, confidential information on your Windows PC, and your Windows Mobile-based Pocket PC or
Smartphone.
This manual contains complete documentation about all the features and functions of Ilium Software
eWallet on a Pocket PC and Smartphone, as well as a Windows (desktop or laptop) PC.
You can also find a step-by-step tutorial for using eWallet on a Pocket PC on our website at eWallet for
Pocket PCs Tutorial.
It’s easiest to use this manual with your Pocket PC or Smartphone running eWallet, so that you can try
out features as you read.
eWallet is also available for Palm Powered™ handhelds. If you’re using eWallet on a Palm handheld,
get documentation for that version on our website.
If you have questions, Ilium Software’s world-class technical support is always happy to answer them.
See Contact Ilium Software for more info.
You can also get additional support, including frequently asked questions, product upgrade information
and tips at any time from our website, www.iliumsoft.com
Thank you for your interest in eWallet.

Supported Platforms
eWallet is supported on the following Windows platforms:
• Windows PC running Windows XP, 2000, 98 or ME.
• Windows Mobile-based Pocket PC (and Pocket PC Phone Edition) 2002
• Windows Mobile-based Pocket PC (and Pocket PC Phone Edition) 2003
• Windows Mobile-based Pocket PC (and Pocket PC Phone Edition) 2003 Second Edition
• Windows Mobile-based Pocket PC 5.0
• Windows Mobile-based Smartphone 2002
• Windows Mobile-based Smartphone 2003
• Windows Mobile-based Smartphone 5.0

How to Use this Document
You can either read through this document, or use it as a reference by looking up the particular
features that you want in the Table of Contents. The first section, Getting Started, contains the
basics of using eWallet.

eWallet User's Guide and Reference: Windows PCs, Windows Mobile-based Pocket PCs and Smartphones

3

Copyright Ilium Software
All rights reserved

Protecting Your Cards contains the most important information about how to be sure that your
cards are protected with eWallet’s strong encryption.
Using eWallet contains detailed information in reference form about all of the features and functions
of eWallet.
If you’d like a step-by-step guide to using eWallet on a Pocket PC, please start by reading our eWallet
for Pocket PCs Tutorial. This will give you a tutorial with all the information you’ll need for using
eWallet to securely keep and use your information.
Most of the information in this document applies to eWallet on Windows Mobile-based Pocket PCs and
Smartphones, as well as Windows PCs. Only some of the interface specifics are different. Any of
eWallet’s features and functions can be used on any of the 3 platforms. To keep the Smartphone
version as small as possible, there are some settings that need to be configured on the Windows PC
version. For consistency, most screen shots show Pocket PC screens, but there typically are parallel
screens on your Windows PC and Smartphone.
Ilium Software, the makers of eWallet, are committed to providing both high-quality software and
excellent technical support. If you have questions about eWallet that this document doesn’t answer,
please do email or call us, and we’ll answer them directly.

Getting Started with eWallet
eWallet is an electronic wallet for your most important personal information (credit cards, calling cards,
passwords, PINs, account numbers and more). Like in your real wallet, eWallet keeps your information
in cards. You can have several related pieces of information on a card. For example, on a password
card, you might have a username, a password and a URL. You can also personalize any card with
icons, colors and graphics, to help you quickly and easily identify each one.
To help keep your cards organized, eWallet puts each card in a category. Any wallet file can have as
many categories as you want, and you can put any kind of card in any category. In addition, categories
can be nested so you can have categories within categories. Like you do with files in folders on your
PC desktop, you can organize your eWallet cards and categories however makes the most sense to
you, and change how you have them organized as you need to.
You can also have as many wallet files as you want, and keep different information in each one. For
example, you might want to have a personal wallet file for your own cards, but an office wallet file that
you share with an assistant or other members of your team. You can duplicate cards between the files
as appropriate. For example, you might want your business credit card listed in both of your wallet files
for extra convenience.
Each wallet file is protected by a password, but you can set this password to be on or off per category.
If a category is password-protected, you must enter the wallet's password before you can see the
information on any of the cards in that category. We recommend that you password-protect all of the
categories in which you keep important personal information.
More detailed information about passwords, wallet files, categories and cards will be found in the
sections below.
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Viewing Information
When you start eWallet for the first time, you'll be using a wallet file with sample cards (My Wallet),
containing examples of categories and cards. Look through this to see the kinds of cards you can
create, and the kinds of information you can put in each one.
You’ll first see 3 sample categories. On the Pocket PC, expand one or more by touching the
in front
of each one. On the Smartphone, expand the categories by selecting one using the 5-way navigation
pad, and then press the center of the pad to expand the category. Pressing the center of the pad again
will collapse the category.
On a Pocket PC:

3 Initial Categories

3 Initial Categories Expanded

On a Smartphone:

3 Initial Categories

Initial Categories Expanded
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On a Windows PC, you’ll see large icons in addition to the list.

The right-hand pane shows the icons for the cards in the category selected on the left.
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On a Pocket PC, you can select either List View (shown earlier) or Icon View:

Icon View showing Category Icons

Icon View showing Cards in the “Samples: More”
Cards category. Note the Category name at the
top of the screen, and the different menu options.

using the View menu on the menu bar. This menu is available when you’re in List View or in Icon View
looking at Category icons (as opposed to looking at icons for cards within a category). The Smartphone
version has a similar feature using the Icon/Tree button.
Look at any card by tapping or clicking its name or icon.
You can look quickly at all the cards without returning to the list or icon view using either the arrow
buttons on a Pocket PC, the Next Card menu option on the Smartphone or the arrow keys on your
Windows PC.
Note that password-protected categories are displayed in black while categories that are not protected
are displayed in blue.
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Main Card display

Details and
Notes area

New
menu
button

Navigation arrows
Smartphone

Pocket PC

When you’re ready to add your own information, you can either add your new categories and cards to
the “My Wallet” and delete our samples, or create a whole new wallet file and add your information to it.

Adding your Own Cards
Add new cards by selecting the New menu button on a Pocket PC, the New->Card menu button on
the Smartphone or the New Card tool button (or Edit menu pick) on a Windows PC.
On a Pocket PC, the New button will make a new object of the appropriate type (depending on your
current location in the program). If you’re looking at a card, or looking at the icons representing cards in
one category, the New button will make a new card in that same category. If you’re looking at the List
View or at icons representing categories, you’ll be given a choice of whether to make a new card (and
which category to make it in) or a new category.
On a Windows PC, you’ll need to have a category or a card selected in the left-hand pane before the
New Card menu choice or tool button is available. The new card will be put into the active category.
When adding a new card, you’ll be prompted for the type of card, then for the specific information for
that card. Use the tabs (on the bottom of the Card Properties window on a Pocket PC, and on the top
on a Windows PC) to change the various kinds of card information. You can add any kind of card in any
category.
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Enter your card information on the Fields tab

Control colors and other appearance options on the
Settings tab

Changing and Deleting Cards
You’ll use the same Card Properties window to change any card.
On a Pocket PC, you can either tap the card face while the card is showing, or Tap + Hold your stylus
on the name of the card or its icon, then choose Properties from the menu that appears.
On a Smartphone, simply view the card you want to change and tap the Edit menu button.
On a Windows PC, just choose the Properties tool button or Edit menu pick when a card is selected.
Delete cards on your Pocket PC by choosing Delete from the menu that appears when you Tap + Hold
your stylus on a card name or icon. Delete a card on the Smartphone by selecting the card in the list of
cards and then tapping the Delete menu button. Delete cards on a Windows PC by choosing the
Delete tool button or Edit menu pick when a card name or icon is selected.

Adding, Changing and Deleting Categories
Just like with cards, it’s easy to add, delete and change your eWallet categories.
To add a category, select New on your Pocket PC when you’re in List View or Icon View looking at
Category Icons, or the New Category tool button or menu pick on your Windows PC.
To change a category on Pocket PC, Tap + Hold your stylus on the name or icon of a category and
choose Properties from the menu that appears. To delete a category, choose Delete from that same
menu. Deleting a category deletes any cards contained in that category as well.
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On a Windows PC, change a category by choosing the Properties tool button or Edit menu pick when
a category is selected. Similarly, choose the Delete tool or menu pick on a selected category to delete
it.
When adding or changing a category, you’ll see the Category Properties window:

Pocket PC

Smartphone

Like with cards, you can change the name of a category and the icon associated with it.
Default Card Type lets you select what will be the initial type selected when you create a new
card in that category. You can always change the card type, and you’re not required to have
only cards of the same type in any category. This pick just controls the initial setting for new
cards. You can pick any of eWallet’s available card types from the list.
The Password Protected option is where you control whether you need your wallet’s password to see
any of the cards in the category. This is the most important thing you need to understand about how
eWallet works.
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Nested Categories
eWallet allows you to further refine your card organization with nested categories. Similar to the
way folders can contain other folders on your PC, categories can contain other categories, or
subcategories. The example below shows two subcategories, Business and Personal, under the
Credit Cards Category. The Business and Personal subcategories would allow you to keep all
your credit cards in one place (Credit Cards) and also separate them in a way that's useful to
you.

To create a subcategory, right-mouse click on an existing category and select New
Subcategory. The new subcategory you create will be nested under the category you clicked on.
To make an existing category a subcategory, simply drag the category you want until it touches
another category; the category you dragged becomes a subcategory of the category it landed
on.
Note that all subcategories of a password protected category will also be password protected.

Protecting your Information
You can think of your eWallet file like your regular wallet. Some of the information is confidential (like
your credit card numbers) and some of it probably isn’t (like your family pictures, or a card with
reference information). eWallet allows you to protect your confidential information, but still have fast
access to other info in your same wallet file.
You do this by putting the cards with confidential information into categories that are passwordprotected, and the ones you don’t want to protect in categories that are not. To password-protect a
category, just select Password Protected on the Properties window for that category.
eWallet will ask you for a password any time you try to see a card in a password-protected category
and your wallet is locked. Your wallet is automatically locked when you first open it, and remains
locked until you unlock it with your password. Then it remains unlocked until you either:
eWallet User's Guide and Reference: Windows PCs, Windows Mobile-based Pocket PCs and Smartphones

11

Copyright Ilium Software
All rights reserved

Close the wallet file
Lock the wallet file (by tapping the lock icon on your menu bar). This icon is grey (disabled)
when your wallet is locked (since you can’t lock it), and green (enabled) when your wallet is
unlocked

Your wallet file is already locked, so you can’t
lock it.

Your wallet file is unlocked, so you can lock it
by touching the lock icon.

or until eWallet automatically closes your wallet file, if you’ve chosen to have it do so. (See below for
information about how to do this.)
On the Smartphone, you can lock your wallet by simply tapping on the Lock Wallet menu button. If the
wallet is already locked, the menu button will be disabled.
In the sample My Wallet file that you’re looking at, the wallet file is currently locked, as you haven’t
entered the password. But since the categories start out without password-protection being on, you
were still able to look at the cards.
For example, if your wallet file has 3 categories:
Credit Cards
Family Pictures
Bank Accounts
you would password-protect Credit Cards and Bank Accounts. When you opened the wallet, it would be
locked. If you tried to look at a card in Credit Cards, you’d be asked for your password. Then, you’d be
able to look at any other cards in Credit Cards, as well as any cards in Bank Accounts without entering
your password again until you locked or closed your wallet.
If you want, you can try this in the sample wallet. The initial password is 123.
We recommend always locking your wallet file when you’re not actively using it.
You’ll also be asked for a password any time you try to change a password or any of the other security
or wallet file options, as well as when you use eWallet’s Find tool. Be sure to change the password on
the My Wallet file, or create your own new wallet file with your own password, before entering any of
your own confidential information.
To change the password of any wallet file, choose Change Password from eWallet’s Tools menu on a
Pocket PC, or eWallet’s Options menu on a Windows PC. If your wallet is locked, you’ll first be asked
for your current password.
To set eWallet to automatically lock any wallet file whenever you’re not using it, choose Configure from
eWallet’s Tools (or Options) menu. From there, you can select timeout locking and other security
features. Read more about these options in eWallet Security.
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Selecting a Password
Choose a password that's easy for you to remember, but would be hard for anyone else to guess. It is
best (most secure) to choose a password that is at least eight characters long and contains at least one
non-alphanumeric character. One convenient way to do this is to choose two unrelated words and
separate them with a dash, asterisk or other non-alphanumeric. For example, "clock-kitten" would be a
reasonable password.
You can optionally set a password hint when you set or change your password. The hint you use
should be something that will remind you of your password, but will not give your password away to
someone other than yourself.
On the Smartphone, if you are using all alphabetical characters for your password, you can tap on the
Use alpha entry option in the password screen. Setting this option will automatically put the
Smartphone in “abc” mode. To manually switch modes between “abc” and “123” and possible other
input modes, press and hold the * key.
Please note that if you forget a password, you will not be able to access any of the protected (by a
password) information in eWallet. Choose your passwords carefully. Remember that passwords are
case-sensitive -- if your password is not being accepted, check that your Shift-Lock is not on.

Getting Started Summary
At this point, you should know:
the difference between cards and categories in eWallet
how to create and change a new eWallet card
how to protect the information in your eWallet files
the difference between eWallet’s List View and Icon View on a Pocket PC
how to use Tap + Hold menus in eWallet.
The rest of this document contains more detail about all the eWallet features, functions and options
available. You can read through them, just use them for reference, or just read the sections you’re
interested in.
You’re now ready to begin using eWallet with your own information. You can either decide first how you
want to organize your information, or just start creating cards. You’ll be able to move them any time
between categories using cut and paste.
It’s also up to you whether you want to keep using the My Wallet file by deleting each card in it and
adding your own, or just create your own wallet file. Again, you can always change your decisions later.

Using eWallet
While using eWallet, keep in mind that some options may be unavailable or work differently depending
on what kind of object you have selected or are viewing. On a Pocket PC, remember to Tap + Hold
your stylus on any object’s name or icon to see the available actions on that object.

eWallet User's Guide and Reference: Windows PCs, Windows Mobile-based Pocket PCs and Smartphones
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eWallet Files
Files are the topmost level of information used by eWallet. Just like any other file on your Pocket PC,
Smartphone or Windows PC, files are completely separate from each other. You can have as many
eWallet files as you want, each with different kinds of information. For example, you might have one
wallet file for work, and one for personal information. Or you might have one file dedicated only to
internet passwords.
On a Pocket PC, you can copy, delete, rename, move or send eWallet files from the file list screen of
eWallet, or using the Pocket PC File Explorer program. On a Windows PC, you can also copy, delete,
rename, move or send eWallet files using File Explorer.
On the Pocket PC you can have two different file lists. The file list on the left shows any wallets you
have that are being synchronized with SyncPro. The file list on the right shows wallets in the “My
Documents” folder area on your device.

eWallet file icon

eWallet files synchronized
with SyncPro

eWallet files under “My Documents” folder
(can be file synchronized)

Create new eWallet files from the New pick on a Pocket PC when you’re in the File List screen. On a
Windows PC, create new eWallet files from the New Wallet pick on eWallet’s File menu.
eWallet files have a file extension of .wlt and an icon showing two cards, one overlapping the other.
Each wallet file has one password, although you can decide for yourself which categories the password
is applied to. Every wallet file must have a password, however. You’ll be asked for a password when
you first create the file. You’ll need the password to view any cards in password-protected categories,
as well as to change any of eWallet’s Configuration Options (including changing the password), and to
use eWallet’s Find tool.

eWallet User's Guide and Reference: Windows PCs, Windows Mobile-based Pocket PCs and Smartphones
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You can choose to have eWallet prompt for your password whenever you open a wallet file, but
remember that you should still password-protect your categories for file security (information
encryption). See eWallet Security for more info.
You can copy or move cards between eWallet files using your system clipboard (Copy/Paste or
Cut/Paste).
If you'd like to share a wallet in a workgroup environment, your wallet files can be placed in a directory
on your network. The first person that opens the wallet can write to the file, everyone else will have
read-only access.
See also:
Synchronization
eWallet Security

eWallet Categories
eWallet uses Categories to organize its information. You can have as many categories as you want in
any wallet, but must have at least one. All cards must be in categories.
Use categories to organize your cards any way that makes sense to you. You can have any kind of
card in any category, and as many or few cards as you want in any category. You can also have as
many categories as you want in any wallet file.
Each category has the following properties:
Name: the name of the category
Icon: the icon representing the category
Default Card Type: this lets you select what will be the initial type selected when you create a new
card in that category. You can always make new cards of any type, and you don’t need to have
only cards of the same in any category. This pick just controls the initial setting for new cards.
You can pick any of eWallet’s available card types from the list.
Password Protected: This option is where you control whether you need your wallet’s password to
see any of the cards in the category. This is the most important thing you need to understand
about how eWallet works. While you have one password per wallet, you can select whether it’s in
effect per category. When a category is password-protected, the cards in it are encrypted in the
file, and you’ll need to enter your wallet password if the wallet is locked. If you’ve already
unlocked your wallet (by entering your password) in your current session (that is, since you’ve
opened your wallet), you won’t need to enter your password again.
We recommend always locking your wallet file when you're not actively using it.
Get a complete description of how passwords work with categories in Protecting Your
Information.
You can change any properties of any category at any time. Categories can be nested to further
organize your personal and business information.
See also:
eWallet Security
eWallet User's Guide and Reference: Windows PCs, Windows Mobile-based Pocket PCs and Smartphones
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eWallet Cards
eWallet stores your information in cards. Think of cards just like any cards in your real wallet – you’ll
usually have several pieces of related information on a card. For example, on a password card, you
might have a username, a password and a URL. You can also personalize any card with icons, colors
and graphics, to help you quickly and easily identify each one.
Each card must be in a category inside your wallet, but any category can have any kinds of cards.
Organize your cards however makes the most sense to you.
You can change any properties of any card at any time, and move cards between categories using your
system clipboard (cut / copy / paste). Edit, delete, rename, cut or copy cards by selecting the
appropriate action from the Tap + Hold menu on your Pocket PC, or the menu bar or tool button when a
card is selected.

Card Types
eWallet provides 32 different kinds of cards for you to choose from (listed below).
Each card has fields and labels appropriate for the kind of information generally kept on that card type.
For example, a credit card form will ask you for:
the card provider
the card type, number and expiration date
the name on the card
your Personal Information Number (PIN)
the customer service telephone number
But you can always enter any kind of information in any field on any card.
You'll notice the Fields area is broken up into two sections: the Card Face Fields section and the
Details Pane Fields section. The Card Face Fields typically contain the items you would see on the
physical card itself (card number, expiration date, etc.) while the Details Pane Fields can be used for
the additional information that goes with the card such as a URL, username and password. You can
enter the information in whatever format is most convenient for you. You can enter any additional
information you might want in the Notes area of any card.
If none of the card templates we provide is exactly what you want for any of your information, eWallet
also contains 2 unformatted card types (Notes and Free Form cards) and one (General Purpose) that
you can customize with your own field labels.
Each card type has a default icon associated with it, but you can change the icon to anything you
prefer. Use the Settings tab on Card Properties to do this.
The following card types are provided in eWallet:
Bank Account - Account numbers for your financial accounts
Calling Card - Telephone calling cards, with access numbers and PINs
Car Info - Information found on your vehicle registration, plus insurance
Cellular Phone – Store your critical mobile phone information
Clothes Sizes - For you, and for the people you buy clothes for
eWallet User's Guide and Reference: Windows PCs, Windows Mobile-based Pocket PCs and Smartphones
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Combination Lock – The combination for any locks or lockers you may have
Contact - Names and phone numbers for personal contacts
Contact Lens Prescription - Prescription information for contact lenses, in case you need to
replace them when away from home
Credit Card - Credit card numbers and info, including PINs
Driver's License – You can also use this card for medical and other licenses
Email Account – System URLs, names and passwords for your email accounts
Emergency Numbers – Fire, ambulance, police and other emergency telephone numbers
Free Form – A short (non-scrollable) card for any unformatted information
General Purpose – 6 fields and labels that you can customize
Health Numbers – Insurance, Hospital, prescription, group numbers, etc.
ID Card – National ID Card or other general purpose ID Card
Insurance Policy - Auto, Life, Home and other policies, with the number to call for claims
Internet Settings – System URLs, names and passwords for your ISP accounts
Lens Prescription – Prescription information for eyeglasses in case you need to replace them
when away from home
Library Card – Number and PIN
Membership Info - Frequent flier numbers, video rentals, store discount, non-profits, and more
Note Card – A unlimited-length card for any unformatted information
Passport Info – Everything on your passport, very important to have a copy
Password – Usernames and passwords you may have on all the computer systems you use
Picture Card – Any picture that fits on your screen, in 2bp or bmp format
Prescription – Dosage and other information for prescription drugs
Serial Number – Your purchases, including serial numbers, model numbers and purchase date
and location information
Social Security Number – Use this for other identification numbers too
Software Serial Number – Registration codes, purchase dates and other software product
information
Voice Mail Info – All the access numbers, passwords and commands you need
Voter Card – Do you remember where to vote from election to election?
Web Site – URL and user or password information for any web sites you log into

Card Properties
In addition to the fields (containing data) in your eWallet cards, you can also control card colors,
borders and other appearance items and the card icon. If appropriate for that card type, you can also
set whether a card is scrollable, whether a hidden field (for example, a PIN) is initially displayed, and
whether the icon displays on the card face itself.
The Settings tab on the Windows PC version of eWallet also has an AutoPass option for cards that
have URLs, usernames and passwords. With AutoPass enabled for the card, eWallet will attempt to fillin the username and password fields for you when you launch the web page from the eWallet card. In
addition to being able to enable and disable AutoPass on each card, you can also control whether the
option gets used at all from the eWallet Options menu.
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Graphics and Sounds
You can greatly customize the appearance of your eWallet cards using graphics and sounds. eWallet
provides several options to let you manage the graphics and sounds in your wallets in the way that
works best for you.
You have 2 options for adding graphics and sounds: linked or inserted.
Linking a sound or graphic file does not add the graphic or sound into your eWallet file. Instead, a
shortcut to that file is added into your eWallet file. If you're synchronizing your eWallet information, we
recommend linking sounds and graphics, rather than inserting them. The shortcuts to linked sounds
and graphics will be synchronized by SyncPro, as well as by Microsoft’s ActiveSync File
Synchronization. In addition, linking graphics or sounds rather than inserting them will improve your File
synchronization time and reliability.
Keep in mind that linked files can only be in the eWallet installation directory and that linking a graphic
or sound file means that the file needs to be on any platform that your wallet is on.
Having graphics linked to wallet files also allows you to use different graphics and sounds for your
cards on each platform. For example, you might create a smaller version of a graphic for use on a
Pocket PC. The link files option makes this simple – just create different graphics, with the same
filename, in the eWallet installation directory on each platform. You also have the option to leave a
linked graphic off of your device: if a linked graphic or sound file is not present on any platform, eWallet
will simply not show the graphic or play the sound.
Inserting a graphic or sound file copies the contents of that file into your wallet. If you’re using eWallet
on a Pocket PC, Smartphone or Windows PC only, this is a simple way to keep your graphics right
inside your wallet files. Note that you should use linking sounds and graphics if you plan to use
SyncPro synchronization.
You can use graphics files in bitmap (.bmp) or jpeg (.jpg) format in eWallet. Graphics can be any size,
but you probably want to size them appropriately for the display.
The following table shows sizes (in pixels) for card displays:

Windows PC
Pocket PC
Smartphone

card size

credit card logo size

312 x 184
237 x 181
170 x 80

95 x 55
78 x 50
54 x 34

The above sizes are for all cards except Notes and Picture cards. Note and Picture cards are not
limited in size.
Sounds must be in wave (.wav) file format. When inserting or linking to sounds that will be used on a
Pocket PC or Smartphone, keep in mind that some devices may not play all sound files. Sounds with a
sampling rate of 11,025 should work on all devices. Sound files with a sampling rate of 8,000 could not
be played on some early devices, and other sampling rates also may not work on all devices.
Please note that graphics and sounds are not encrypted, even when placed in a password-protected
category.
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You can get graphics and sounds from any source, as long as they’re in the above formats. Many
websites have sounds and graphics available for download.

Icons
You can add custom icons for cards and categories by creating Icon (.ico) files using any Windows PC
icon editor. Each Icon file should contain one icon, in both 32x32 and 16x16 sizes. On your Windows
PC, you’ll need to put your icons in your eWallet installation folder. To use the Icon file on your
Windows Mobile-based Pocket PC or Smartphone, use ActiveSync Explorer and drag the icon from
your Windows PC to the eWallet installation folder on your device. Once this file is on your Windows
Mobile device, you can use it just like the built-in icons.
In pre-4.0 versions of eWallet, icons moved to a Windows Mobile device were converted to files with a
.bmi extension. These files will continue to work on your mobile device but you may also replace them
with .ico files if you wish.

eWallet Security
eWallet protects your wallet information in 2 ways:
by requiring a password before displaying any cards in password-protected categories, and
by encrypting (making unintelligible) the information in cards in password-protected categories
in your wallet file. This means that the information in the file is scrambled so that it can’t be read
by any other program.
eWallet requires a password for each wallet file you have, but the password can be on or off for any
categories in that file. Read Protecting your Information for more information about how passwords
work.
For quick access, you can have categories that aren’t password-protected, but information on those
cards will not be protected in either way described above.
You can protect as much or as little of your information as you choose. Again, eWallet will encrypt only
the data in the categories of your wallet that you specify as password-protected. Cards in other
categories will not be encrypted, and will be viewable without your password.
We recommend using categories without passwords only for general, non-confidential information.
eWallet uses the RC4 encryption algorithm, with a 128-bit key to encrypt any of your cards in
password-protected categories.
Note that the trial version of eWallet will not encrypt any data until registered. When you purchase
eWallet, all password-protected cards in the wallet that was open when you registered will automatically
be encrypted. To encrypt any password-protected cards in other wallets you may have created with an
unregistered version, just open each wallet with the registered version of eWallet and you’ll be given
the option to encrypt your password-protected cards. Also, please note that pictures and sounds are
not encrypted, even when placed in a password-protected category.
You can explicitly lock your wallet at any time, with the Lock Wallet tool button. Locking your wallet
leaves it open, but closes each category. A password is required to open any password-protected
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category. You never need to explicitly unlock a wallet – just choose which category you want to open,
and you'll be prompted for your password.
You can increase the security of your eWallet installation using options available from the Configure
pick of the Tools (Pocket PC) or Options (Windows PC) menu. On the Smartphone, tap the Options>Configure menu button. These options include:
Having eWallet close or lock your wallet after a specified amount of time if it doesn't get any
user input. Both of the options will act on any wallet when it's open, whether it’s active or
minimized. Once the wallet is closed or locked , the password will again be required to access
any password-protected information. Choosing this option will help prevent someone being able
to see your information if you've unintentionally left your wallet open.
Having eWallet lock out wallet access if a specified number of incorrect password attempts are
made. Once the wallet's access is locked, passwords cannot be entered and password
protected data cannot be accessed. You can choose how many incorrect password attempts
will be allowed before the wallet's access is locked, and how long the wallet's access stays
locked once the limit has been reached. This will make it more difficult for someone to try to
break into your wallet by guessing several passwords. However, it will also make it more difficult
for you to try multiple passwords if you misplace or forget one, so use this option with care.
Having eWallet ask for your password when the wallet is first opened, rather than waiting until a
category is accessed. With eWallet version 2.1 and later, selecting this option will also
password-protect any non-protected categories. If you select this option, you should still
password-protect any new categories you add containing cards with confidential information.
You’ll still need to only unlock your wallet file once per session.
To change the password on your eWallet, select Change Password from the Tools or Options menu.
You will first be asked for your current password. You will only be allowed to enter a new password
after you've correctly entered your current password.
Choose a password that's easy for you to remember, but would be hard for anyone else to guess. It is
best to choose a password that is at least eight characters long and contains at least one nonalphanumeric character. One convenient way to do this is to choose two unrelated words and separate
them with a dash, asterisk or other non-alphanumeric. For example, "clock-kitten" would be a
reasonable password. Please note that if you forget a password, you will not be able to access any of
the protected (by a password) information in your wallet file. Choose your passwords carefully.
Remember that passwords are case-sensitive -- if your password is not being accepted, check that
your Shift-Lock is not on.
See Also:
Protecting your Information

Synchronization
eWallet 4.0 lets you choose between two ways of synchronizing your information: SyncPro™ and File
Synchronization.
With SyncPro Synchronization, you can make simultaneous changes to different cards on your
Windows PC and Windows Mobile device and both changes will be synchronized. If you're using File
Synchronization, however, you cannot update one record in a wallet (your Visa card, for example) on
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your Windows PC and another (your calling card) on your Pocket PC and have both changes take
effect. Only whole files are synchronized.
The Status Bar at the bottom of the Windows PC version of eWallet will show you the type of
synchronization you have set for the currently opened wallet file.
Use the picks on eWallet’s Synchronization menu to change synchronization settings for your open
wallet file. To change settings for another wallet file, first open the file, then use the Wallet
Synchronization Wizard.
See Graphics and Sounds for information about the choosing the best options for using graphics and
sound files in wallets that are synchronized.

SyncPro Synchronization
With SyncPro™ Synchronization, you can make simultaneous changes to different cards on your
Windows PC and Windows Mobile-based Pocket PC or Smartphone, and all changes will be
synchronized. SyncPro allows two-way card synchronization with one Windows Mobile device as well
as an automatic wallet file copy to any other connected Windows Mobile devices.
SyncPro is for use only with Windows Mobile-based Pocket PCs and Smartphones. If you have a Palm
Powered handheld, use HotSync to synchronize your eWallet information.
We recommend you install the latest version of Microsoft ActiveSync for use with SyncPro.
Follow the steps below to set up your Windows PC and Pocket PC or Smartphone for synchronization:
1. Make sure your Windows PC and your mobile device are connected using Microsoft
ActiveSync.
2. Start the Wallet Synchronization Wizard by selecting Synchronization Setup from eWallet's
Synchronize menu. When you're ready, press Next.
3. Select your device in the wizard and press Next.
4. Pick the Synchronization Action you'd like and press Next.
5. Press Finish.
If you've already established Synchronization and would like to change it, select Change Partner from
the Synchronize menu.
Remember that your eWallet password on your Windows Mobile wallet file and the wallet file you
synchronize with on your Windows PC need to be the same.
Synchronization
Options
Synchronize Cards
PC Cards overwrite
Device cards
Device Cards overwrite
PC cards
Do Nothing

When to use
You have important information in both your Windows PC wallet and in the
wallet cards on your Windows Mobile device.
You have important information in the wallet file on your Windows PC and
are not worried about the existing information in your Windows Mobile
wallet file.
You have important information in the wallet file on your Windows Mobile
device and are not worried about the existing information in your Windows
PC wallet file.
No synchronization will occur.
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Notes:
•
•

Once a wallet has been configured as a SyncPro wallet, it will be stored in the Synchronized
Wallets folder in the eWallet installation directory on your Pocket PC or Smartphone.
Some card elements such as embedded graphics and embedded sounds are not synchronized
using SyncPro. See the Graphics and Sounds section for more information on this topic.

SyncPro Settings
You can control when SyncPro synchronization occurs and if you want to confirm each synchronization.
Note that SyncPro will check all your SyncPro wallets when synchronization occurs but will only
synchronize the wallets that need it.
Synchronization Occurs
Manually
SyncPro synchronization will occur only when the "Sync Now" button is pressed in the
Only
toolbar or when "Run SyncPro Now" is selected from the Synchronization menu. This
is useful if you change cards very rarely or want complete control over when
synchronization occurs.
On eWallet
SyncPro synchronization will occur when eWallet on the Windows PC starts. Useful
Start
when you primarily change cards on your Windows PC.
On eWallet
SyncPro synchronization will occur when eWallet on the Windows PC exits. Useful
Exit
when you primarily change cards on your Windows PC.
Connect to
SyncPro synchronization will occur when your mobile device is connected via
mobile
ActiveSync. Useful when you primarily change cards on your mobile device.
device
Note that synchronization will never be confirmed when the synchronization is
initiated on a mobile device connection. If you're connecting remotely (using WiFi for
example) you would not see or be able to respond to the confirmation prompt.
Confirmation
Always
Never
Only when I have
multiple SyncPro files

Always prompt for confirmation before SyncPro runs.
Never prompt for confirmation before SyncPro runs.
Select this confirmation option to prompt for confirmation if you have more
than one wallet file to be Synchronized with your Windows Mobile device
using SyncPro.

ActiveSync File Synchronization
If you have a Windows Mobile-based Pocket PC, you can use File Synchronization (part of Microsoft®
ActiveSync®) as an optional alternative to SyncPro to keep the wallet files on your Windows PC in sync
with the wallet files on your Pocket PC. We recommend you install the latest version of Microsoft
ActiveSync.
Your wallet file may already be synchronizing. Check the status bar at the bottom of your eWallet
window on your desktop to see if it is.
To set up your Windows PC and mobile device for File Synchronization, follow these steps:
•

Enable File Synchronization. In Microsoft ActiveSync 3.7 or later, you do this by selecting
Options from the Tools menu. Check the box for File Synchronization and click OK.
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•

For new wallet files, pick the ActiveSync File Synchronization option in the New Wallet
Wizard. This will store your new wallet file in the Synchronized Files folder on your Windows
PC. To change settings for another wallet file, first open the file, then use the Change Partner
pick on eWallet’s Synchronize menu. If you’re already using ActiveSync File Synchronization
for your wallet files, you don’t need to make any changes.

•

Store your wallet files in the ‘Synchronized Files’ folder on your Pocket PC. Your wallet files are
always stored in the "My Documents" folder, which is always synchronized (files stored on flash
cards will not be synchronized, however).

Once you have this set up, your wallet files will be synchronized whenever you synchronize the rest of
your data. If eWallet is running when you synchronize, you may get a message that the wallet file is in
use. If this happens, close eWallet and synchronize again.
If you don’t want a Windows PC wallet file synchronized with your mobile device any longer, simply
move the file out of the ‘Synchronized Files’ folder on your Windows PC. You can find out where this
folder is by opening the ActiveSync Options dialog, selecting File Synchronization and clicking the
Options or Settings button.
If you are using a eWallet on a Windows Mobile-based Pocket PC or Smartphone, you have the option
of using SyncPro Synchronization. Note that Microsoft does not provide File Synchronization for
Windows Mobile-based Smartphones.
If you have more than one Pocket PC, you’ll probably have more than one File Synchronization partner
on your Windows PC. You’ll be able to choose which one to use for any new wallet, or any wallet that
you’re changing to use File Synchronization.
See Graphics and Sounds for information about the choosing the best options for using graphics and
sound files in wallets that are synchronized.
If you have problems with synchronization, you can find detailed support information on our website at
http://iliumsoft.com/site/support/fsynchlp.htm.

Exiting eWallet
On Pocket PCs and Smartphones, you typically don’t have to worry about exiting out of eWallet; the
Windows Mobile operating system handles memory and applications automatically if necessary. If a
situation does arise where you need to stop eWallet from running, follow one of the steps below:
• For Pocket PC: enter Ctrl-Q on the keyboard from a card or category view.
• For Smartphone: in eWallet, tap About eWallet on the Menu button. With the About screen
displaying, enter the “Q” (on the 7) key.

More eWallet Features
For extra safety, we encourage you to make backups of your eWallet files (as well as all of your
important information). On a Windows PC, you’ll find a Make Backup pick on eWallet’s File menu. On
a Pocket PC, just choose Create Copy from the Tap + Hold menu on any eWallet filename.
If you delete a lot of cards, you might want to compact your eWallet file to reclaim wasted file space.
Just use the Compact Wallet pick on eWallet’s Tools (Pocket PC) or File (Windows PC) menu.
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Use eWallet’s Find and Find Again commands to quickly find cards.
On the Windows PC, when you use the Copy Card Number menu command on a credit card, only the
digits will be copied to the Windows clipboard. Spaces and dashes are removed using this copy
command to make pasting to forms on web sites easier. You can also copy information from a specific
card field by right-clicking on the field and selecting the appropriate Copy menu option.
On a Windows PC you can choose to hide or show the Notes pane, as well as changing its position and
the positions of the other panes. You can resize the Notes area on any platform by just dragging the
edge of the pane. You can also change your wallet’s background color on any platform.
You can print your wallet from your Windows PC using eWallet's Print pick. Print your entire wallet
using the Print All option on the Print window. Select one card or one category, and the Print Selection
option, to print only specified sections of your wallet.
eWallet will print the PIN or password on a card if you have configured the card to display it. You may
want to hide PINs and passwords on all cards before printing. We recommend that you do not write
PINs on your printouts for security reasons.
You can export your eWallet information to a text file for printing or extra backup with the Export pick.
This will copy all the information on each card in your wallet to the file you specify. Please note that
exported information is not secure, and that any colors, graphics and sounds associated with a card are
not exported.
Get eWallet Tips and Hints from eWallet’s help, on your Windows PC or Pocket PC. To use eWallet’s
Help on your Pocket PC, just choose Start->Help when eWallet is on your screen.
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Getting More Information
Online Information
Frequently asked questions, tips, upgrade information and other support information is available at any
time on the eWallet Support page of our website.

Contact Ilium Software
Ilium Software, the makers of eWallet, are committed to providing both high-quality software and
excellent technical support. If you have questions about eWallet that this document doesn’t answer,
please do email or call us, and we’ll answer them directly.
For Technical or Customer Support, email us at support@iliumsoft.com any time, or
or phone us at (888) 632-5388 (toll free) or +1 (734) 973-9388
You can buy any of our products using our secure Online Store or Special Order Form found at
http://www.iliumsoft.com. You can also send order information to us orders@iliumsoft.com or mail, fax
or phone us your order at the address or number given below.
Ilium Software
3759 Prospect
Ann Arbor, MI 48105 USA
http://www.iliumsoft.com

info@iliumsoft.com
tel:
+1 734 973 9388
tollfree (US):
888 632 5388
fax:
+1 734 973 2640
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